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Summary

This presentation covers first the strategy behind Development Studio Client and is 
then followed by a review of the Remote System Explorer in Development Studio 
Client Version 5.1
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1988 In the beginning, there was 
PDM and SEU

In the beginning, there was SEU, PDM, SDA, etc
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1992
CODECODE

Not your father's SEU!Not your father's SEU!

And then came CODE/400!

Then came CODE/400, in 1992 on OS/2 and in 1997 on Windows.
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2002… Now, there is RSE in WDSc!

Today, we have the follow-on to CODE… the Remote System Explorer in 
WebSphere Development Studio Client.
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+CODE
+VisualAge RPG

www.ibm.com/software/awdtools/wds400

WebSphere Development Studio V5.1

There is now only one application development product sold by IBM, for iSeries, as of V4R5. This is 
WebSphere Development Studio (Development Studio), which includes all four host compilers, all 
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the 
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere 
Development Tools). 

If you are an existing customer who has a subscription, you can upgrade to Development Studio free 
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development 
Studio are priced very competitive compared to the combined prices of all constituent products. As of 
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or 
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools, 
Development Studio Client is also made available as a passport advantage product so it can be 
purchased "off the shelf" from IBM Direct. 

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every 
development machine used to have PDM and SEU, every development machine will now have all the 
modern Application Development tools from IBM. This ubiquity is especially important for business 
partners who build and sell software. These Business Partners are now free to build software using 
any of the technologies or tools in Development Studio, and can assume their customers will have 
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively 
raises the lowest common denominator to a level unparalleled by any other operating system. 
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Cost Upgrade 5906 (V5R1) or 

5914 (V5R2)

The Advanced edition of Development Studio Client, and Development Studio, is 
new as of April 25th 2003. Development Studio Advanced is currently the same as 
Development Studio, except the customer is entitled to unlimited licenses of 
Development Studio Client Advanced versus just Development Studio Client. 
Version 5.1 became available on October 17, 2003.

The difference of Development Studio Client Advanced over Development Studio 
Client is that it has additional tools (blue boxes with asterisks) and some 
enhancements to existing iSeries tools (green boxes with asterisks) which will be 
discussed later in this presentation. The majority of the new tools are related to 
Enterprise Java Bean (EJB) development. You’ll see later that Development Studio 
Client Advanced is based on WebSphere Application Developer (Application 
Developer) versus WebSphere Studio Site Developer (Site Developer).
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WebSphere Studio Family

Enterprise Developer

AD-Integration Edition

Application Developer

Site Developer
WS Workbench

Eclipse

Dev’t Studio Client

Site Developer

Eclipse

Dev’t Studio Client Advanced

Application Developer

Eclipse

Here you see that Development Studio Client is based on WebSphere Studio Site 
Developer, while Development Studio Client Advanced is based on WebSphere 
Studio Application Developer. 
The Workbench is based on the open-source Eclipse technology about to be 
discussed. It is not for sale, but is the basis of all IBM WebSphere Studio products, 
and is available to business partners. 
Site Developer is IBM’s entry level offering based on eclipse, and it is for building 
dynamic Web sites out of non-EJB Java. Application Developer extends Site 
Developer and adds support for EJBs. Application Developer-Integration Edition 
extends Application Developer and adds support for JCA Connectors and for 
Workflow. Enterprise Developer extends Application Developer-Integration Edition 
and adds support for S/390 and Enterprise Generation Language (EGL), the follow-
on to VisualAge Generator.
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Eclipse User Interface – Select Perspective

Users work with perspectives
–Collection of editor and views

–Tools for a particular task
–Allows for role-based development

–Many perspectives are pre-supplied for 
specific tasks like Java, Web, XML, RPG/CBL

–Users can create their own perspectives

The user interface is very Windows-like
–Eg: views can be re-sized and re-positioned 
through drag ‘n drop

The core features of the Eclipse user interface include perspectives which is a 
collection of views and tools. Perspectives allow role based development. For 
example, if you are a Java developer you would use the Java perspective which 
includes tools and views for Java development. You can also create your own 
perspectives. Naturally, the Eclipse user interface applies to all Eclipse-based 
products, like Development Studio Client.
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Eclipse User Interface – Perspective

Editor

View

View
View

View

Other 
open 

persp’vs

Active 
persp’v

Other 
open 
views

An example of an eclipse perspective… the active one contains the editors and 
views you see. Other perspectives can be open simultaneously, but not active. 
These are shown in the tray on the left, and can be made active by simply clicking 
on them. To open new perspectives, use the Window pulldown.



11

IBM Software Group  |  WebSphere software

iSeries Tools |  Remote System Explorer © 2004 IBM Corporation11

Table of contents

Development Studio Client

Remote System Explorer
Subsystems, filters and actions

Editors

Designer

Integrated iSeries Debugger

Summary

Now you know the story behind Development Studio Client. Lets look at the Remote 
System Explorer, the tool for iSeries application development and maintenance. 
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RSE Perspective – PDM Drill down, Filtered 
Access

iSeries QSYS artifacts
libraries, objects, members, records, fields, modules, etc

iSeries Jobs

iSeries IFS Folders and Files, and QShell Cmds

Local Folders, Files and Cmds

Remote Unix, Windows, Linux Folders, Files and Cmds

The Remote Systems Explorer goes well beyond PDM! It also allows exploration of 
iSeries jobs and commands, and the IFS file system. Further, it can also be used to 
explore the file system of remote Linux, Unix and Windows systems. The Linux 
support works for any Linux, including Linux in an iSeries Logical Partition.
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RSE Perspective

“Local”
connection is 
pre-defined

Expand to 
create new 

“connection”

When you first open the Remote System Explorer, you are not connected to any 
system except your local hard drive on our workstation. To connect to a remote 
iSeries host, you need to define a connection.  In the Remote Systems view you 
use the New Connection wizard to configure a connection to your iSeries host. You 
can also use the Remote Systems view to explore the file system of remote Linux, 
UNIX and Windows systems. The Local connection is pre-defined.
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RSE Perspective

Prompted to 
signon on 

expand

After creating an iSeries connection, and then expanding it to the point where stuff 
from the iSeries is to be shown, you are asking to signon to the iSeries. You can 
optionally choose to remember the user ID and password, such that you won’t be 
prompted again for them. 
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RSE Perspective

Icon changes 
when connected

Once a communication session is established with the target iSeries system, the 
icons for the connection, and the nodes immediately underneath it, change to have 
a small green arrow indicating you are connected. Of course, you also then can 
expand to see resources from that iSeries.
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What is an RSE “Connection”?

Represents a remote system
Given an arbitrary name

Multiple connections to one system permitted

Contains environment info 
Such as library list and environment variables

Specified in properties dialogs of connection

Used in many Development Studio Client for 
iSeries tools

RSE, iSeries Projects, Java Tools, Web Tools,  WebFacing

A very central concept to all of Development Studio Client for iSeries is that of 
connections. A connection defines information needed to access a remote system. 
Each connection is given an arbitrary name by you, and so multiple connections to 
the same system are permitted. Each connection also captures information that is 
applied when connecting to that remote system, such as the initial library list for 
iSeries connections. All iSeries tools within Development Studio Client for iSeries 
use connections to access a remote iSeries system. Connections are created and 
managed in the Remote Systems Explorer.
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Working with RSE Connections

Remote Systems view 
manages connections

Create connections here 
(using wizard)

Change, rename, copy, 
delete them here

Expand them to work with 
resources here

The Remote Systems view is the primary view for managing connections, via right 
click actions. While this view is normally accessed in the Remote Systems Explorer 
perspective, you can open any view in any perspective.
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iSeries Connections
Connections expand to

–“subsystems”
–Named grouping of functionality

Subsystems for iSeries connections:
–iSeries Objects

–For working with Libraries, Objects and Members
–iSeries Commands

–For pre-defining and running QSYS command sets
–iSeries Jobs

–For working with jobs
–IFS files

–For working with Integrated File System files and commands

1

2

3

4

Once connections are defined they can be expanded within the Remote Systems 
Explorer. On expansion, the user sees subsystems, which are merely a functional 
grouping of the various types of remote resources that can be explored in the 
remote system
For iSeries connections, there are four subsystems:
•iSeries Objects is the PDM-like grouping, allowing access to libraries, objects and 
members
•iSeries Commands allows developers to predefine command sets each of which 
contain one or more often used commands. When run, all commands in a command 
set are sent to the remote system and executed, and the results are logged in the 
Commands view.
•iSeries Jobs allows developers to see various jobs, subsettable by job attributes, 
and to perform a limited number of operations on those jobs
•IFS Files allows developers to explore folders and files in the Integrated File 
System of the remote iSeries system
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iSeries Objects

For drill-down or filtered 
access to QSYS

Libraries, objects, mbrs
Expand lib to see objs
Expand file to see mbrs
Expand device file to 

see record fmts, then flds
Expand pgm/srvpgm to 

see modules 
Expand msgf to see 

messages

Similar to PDM

Create new 
filters

Supplied filters
User filter

Objects within 
expanded 

library

Members within 
expanded file

1

The iSeries Objects subsystem is the subsystem you will use most often! It is very 
similar to PDM, in that it allows you to access objects in the QSYS file system, and 
perform actions on those objects. 
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“Library list” is a pre-
defined filter

For accessing and 
manipulating libl

Like WRKLIBPDM 
with *LIBL

Filter actions to add 
to library list, change 
current library

Library actions to 
move within libl, 
remove from libl, add 
to libl, change curlib

1

When the pre-defined library list filter is expanded, and the connection is successful, 
you will see the libraries on your library list.  For each library, you can right-click and 
select from a number of useful actions. There is an action to create a new source 
file within the selected library, to refresh the contents of the library if it is expanded, 
to rename the library, copy the library or delete the library. These last three actions 
remotely run the appropriate iSeries command and you will see it logged in the 
Command Log view. 

If you expand a library, you will see all the objects in that library... 
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Use “Work with xxx”
to create own filters

Like WRKxxxPDM!

1

The three child items at the top of the list are for creating filters, much like in PDM:
-Work with libraries... prompts you for a simple or generic library name,  and lists all 
matching libraries. It is similar to WRKLIBPDM.
-Work with objects... prompts you for a simple or generic library name and simple or 
generic object name, as well one or more object type and attribute pairs. It lists all 
matching objects in all matching libraries. it is similar to WRKOBJPDM.
-Work with members... prompts you for a simple or generic library name, simple or 
generic file name, and simple or generic member name, as well as one or more 
member types which can also be generic. It lists all matching members in all 
matching files in all matching libraries. It is similar to WRKMBRPDM. Unlike PDM, 
the filters you create are permanently remembered and displayed in this list for easy 
re-use. We will have more to say about filters. To simulate STRPDM's option 12, 
you can start with the pre-defined Library list filter, that when expanded lists all 
libraries in your library list. With any filter, once it is expanded you can subsequently 
expand a library to see all objects in the library, and expand files to see all members 
in the file. When you expand your first filter, such as the pre-defined Library List 
filter, you are prompted for your password and then connected to the remote 
iSeries. Then, the results of resolving the filter are shown...
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iSeries Commands

For commonly-used 
commands

Create command 
set with one or more 
CL commands

Expand to run 
commands

Create new 
command 

set

Supplied 
cmd sets

User set

Messages 
resulting from 
running cmd

2

The iSeries Commands subsystem is merely a place for creating often-used 
commands. The commands are created in a Command Set, which is simply a 
named list of commands. By default you are only prompted for a single command, 
but after creating the command set you can use the Change action to add more 
commands. 

Once a command set is created it appears in the tree. There are a number of 
command sets pre-supplied by IBM. When a command set is expanded, the 
commands in it are run and any messages are shown as children of the command 
set. The commands are also logged in the command log view.

This is only one way to run commands in the RSE. There is also a Command Log 
where you can enter commands just like a command line on the iSeries. You will 
see that you can also create user-defined actions that appear in the menu for 
selected objects and members, just like PDM user defined options. 
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iSeries Jobs

For accessing jobs

Like WRKxxxJOB

Create filters to 
see jobs with 
specific attributes 
(right click)

Use predefined 
filters to see your 
own jobs

Supplied 
filters

User 
filter

Job
actions

3

The iSeries Jobs subsystem is for working with jobs.  

As with all subsystems, you can create filters (by right clicking on iSeries Jobs) to 
see just the jobs you want to see. There are three pre-defined filters for you to see 
all active jobs, only your active jobs and all your jobs.

The job’s icon indicates if it is active, done or queued. 

Right clicking on a job allows you to work with the job.
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IFS Files

For accessing 
folders and files

Like WRKLNK

Create filters to see 
files in specific folders 
(right click)

Use predefined 
filters to drill down

Open command 
console (right click on 
IFS Files) for QShell

4

Supplied 
filters

User 
filter

File
actions

The IFS Files subsystem allows you easy access to IFS folders and files.

Like all subsystems, you can define your own filters and there are some pre-
defined. In this case, the filters allow access to files within a particular folder. 

Right-clicking offers access to a very rich set of actions you can perform against the 
selected folders and files. You can even create your own user actions, as can for 
the iSeries Objects and iSeries Jobs subsystems. 

To run QShell commands, right click on the IFS Files subsystem object and select 
the Launch Shell action. This opens a command console that is also very rich in 
function.
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SubSystem Properties

Right click on any 
subsystem in an 
iSeries 
connection to 
configure it via 
Properties

Specify compile 
preferences

Specify 
environment 
variables

Specify library list

All iSeries subsystems allow you to configure properties via the Properties action in 
the right-click menu. These properties are run-time properties that are applied when 
the connection is connected to the remote server.

A popular question is how to setup the library list such that it is set every time, 
without manual intervention. This is where to do that. 
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iSeries Objects

The following focuses on using the iSeries Objects 
subsystem to work with artifacts in your native 
QSYS file system

1

Now we drill down on the iSeries Objects subsystem, which is by far the most 
heavily used.
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Creating New 
Things
Right click for “new”
actions

On library filter for new 
library

On library object for 
new objects

On file object for new 
member

On msgf object for 
new message

To create new objects, right click on a library to get access wizards for creating 
some of the more popular objects for developers. Of course, you can also use the 
command log or a command set to do this, but these wizards help by simplifying the 
command. 
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Working With 
Things
Use right click actions

*LIB *PGM

*FILE

MBR

These are some of the right-click popup menus, based on object type. This shows 
how rich the functionality is. Indeed, it is a superset of PDM’s functionality. 
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Properties
Use Properties view for quick access to common properties

Use Properties 
dialog for access 
to all properties

Directly editable

The Properties view is normally in the lower left of your RSE perspective. It is where 
common information about the selected object is shown, some of which is directly 
editable, such as the Text property, which changes the text of the object on the 
iSeries. 

For a full set of all the properties, right click and select Properties from the bottom of 
the object’s popup menu
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iSeries Table View

Same popup 
actions in table, 

and tree Sort by 
clicking on 

column 
heading

Double click 
to drill into

For libraries and files we can use a pop-up menu action to open table views to see 
the contents of the library or file. In these tables, the columns are attributes for the 
object or member in each row. The table can be sorted by an attribute by simply 
clicking on the column heading. 

The Show In Table action is available for every tree node that has children.
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iSeries Table View
Use local pulldown to see 

additional columns

Can also 
Change contents
Subset contents

Position list
Print list

…. Just like PDM!

When listing objects in a library, in a table view, you can turn on “Additional 
information” to see more attributes: date-created, date-changed and size. Combined 
with the sorting capability, this can be very powerful.

The same little pulldown menu has other actions that PDM users will be familiar 
with. 
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iSeries Table View

Special PDM Options menu 
for PDM users

While there is nothing new in this menu, there is a PDM Options menu in the right 
click menu from the table view, which shows all the actions by the numbers their 
corresponding option was in PDM, to help with the learning curve of PDM users. 
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RSE Command Shell

•Enter command, 
press Enter

•Use arrows to 
retrieve commands Prompt Run

Show Log

Like PDM, there is command line at the bottom of the table, and it can be used to 
enter command to be prompted and run. When run the results are shown in the 
messages combo box, and the command log can be seen via the Show Log button. 

Note that in 5.1, you can use F4 and F9 in this command shell. 
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Multi-file Search

Select Search-
>iSeries from 

pulldown menu

GUI interface to 
FNDSTRPDM

Now supports 
generic names in 

5.1

Often we need to search through members looking for strings. To this from the 
RSE, there is a dialog to help with it. It supports the same options as FNDSTRPDM 
… actually more as it allows generic library and file names (as of 5.1).  Indeed, this 
actually ends up calling FNDSTRPDM to do the search. 
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Search Result

Double click on 
match entry to 

open+position in 
editor

The result of searching is a hit-list view where the resulting matches are shown. 
They can be double-clicked on to open the editor to the line with the match. 
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RSE Drag and Drop

Within same 
connection

Between 
connections

Between command 
shell and tree view

Between table view and 
tree view

From tree/table 
view to editor (5.1)

From tree/table 
view to filter (5.1)

RSE has rich support 
for drag and drop

Same as using 
Copy and Paste

Here you can see that you can drag and drop files or copy and paste files across 
multiple file systems, within the same connection and using the Remote Systems 
view, iSeries Table view or the Command Shell.
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RSE: User Actions
User-Defined Actions 
(like PDM!)

– Right-click on 
iSeries Objects or 
any iSeries object 
member

– Work With User 
Actions

– Create, delete 
or change user-
defined actions

– Scope them by 
type and 
attribute 

While IBM supplies a number of useful actions for remote iSeries objects, it is not 
possible to supply them all. Like PDM, you can easily define your own actions.  To 
create your own actions, use the Work With actions in the popup menu for iSeries 
Objects. These user-defined actions will appear in the popup menus for remote 
resources. To avoid seeing all actions in all popup menus, you scope each action to 
a one or more object or member types. You first define named collections of object 
or member types, then you create your actions and scope them to one of these 
named collections of types. You actions will then only appear for object or members 
that match one of the types in the collection.  If you are a CODE user, you can use 
File->Import to import existing actions from CODE Project Organizer.

You can also create user actions for Jobs and for IFS (or local/windows/unix/linux) 
folders and files.
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RSE: User Actions

Use Ctrl+Space
to see sub vars

Supports all 
PDM vars, + 

more !

Scope by 
object type and 

attribute

Many 
options

Here is what the dialog that is used to define new user actions looks like.

An action is a name (shown in popup menu), comment, command and a number of 
options. 

All PDM’s substitution vairables are supported plus additional ones. Use 
Ctrl+Space, or press Insert variable, to see all the available variables. 

Actions are scoped such that they only appear in the menus for the objects and 
members they apply to. This is better than PDM allows. Also, you can specify if the 
command should be prompted before running, whether to refresh the list after 
running the command, and whether the action should only appear if one item is 
selected, or what to do if multiple items are selected. 
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Use your action you just created!

Once your action is defined, you can use it. Right click on an object matching one of 
the types you specified, and expand the User Actions menu in the pop-up. Your 
action appears in the menu. Select it. If you chose to prompt the command, you will 
see the GUI prompt for the command. When the command has finished running, it 
results are logged in the Commands view. 
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Remote System Explorer

Editors



41

IBM Software Group  |  WebSphere software

iSeries Tools |  Remote System Explorer © 2004 IBM Corporation41

Editors

Launch 
external CODE 

editor

Launch built-in 
Lpex editor

For a source member, there are two options for editing: 
1. Remote Systems LPEX Editor. This is the new editor, written all in Java, that is 

built-in to the IDE. It is a re-write of the original CODE Editor, but as you will see 
has a subset of the functionality in CODE at this point.

2. CODE Editor. This is the classic full-functioned CODE editor, which is offered as 
an alternative until the Lpex editor catches up to the functionality of the CODE 
editor. This launches the CODE Editor in a separate window. 

We will cover the Remote Systems LPEX editor next in more detail...
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LPEX (“JLPEX”) built-in IDE editor

Tab for each
open memberF4

Disable/Enable
Prompter and

Syntax checking
Toggle insert/replace

The Remote Systems LPEX editor is built-in, so it shows up in a pane within the 
IDE. You can open multiple members for editing, and each will be shown in the 
editor area with a tab that when selected brings that member to the foreground. You 
can double click on a tab to expand that member's edit window to full size. When a 
tab shows an asterisk in it, that indicates there are pending changes that should be 
saved. For RPG (both III and IV) you will notice there is color highlighting and 
familiar F4 support to prompt for the current line. The prompter sits is a view that 
doesn't overlap the editor. When done filling in the prompt, you can press one of two 
buttons to replace the current line or insert a new line.
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LPEX Editor Functions: Edit pulldown

Edit menu when Lpex
editor has focus

Find 
actions

Selection actions

Tools

This shows the Edit menu, when the editor is open and in focus. This menus offers 
actions for clipboard, searching, selecting and a number of cool tools.
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LPEX Editor Functions: Source pulldown

Create new procedure
Prompt

Syntax check
Program verify

Show indent view
Show fields of selected 

F-spec
Open select /copy 

member
Resequence

This is the Source menu when the editor is open and in focus. It has a number of 
actions that apply to the entire source member, as opposed to what is selected. 
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LPEX Editor Functions: Context menu

Selection actions

Filter actions

Clipboard actions

Here we see the pop-up menu within the LPEX editor.  This contains clipboard and 
selection actions, as well as filtering actions which we will discuss.
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LPEX Editor 
Functions: 
Preferences

There are also 
a number of 
cool functions 
you can 
enable via the 
editor 
preferences
– Window-

>Preferences

Show date in prefix area 
Column-sensitive editing
Add signature to lines

Resequence increments
Highlight current line

There are a number of other interesting Editor capabilities available for enabling in 
the editor’s preference page. The most exciting of these are the column-sensitive 
editing and the highlight current line option. The former allows editing within a range 
of the RPG/DDS spec such that other areas of the same line are not affected by 
insert or delete, while the latter highlights the line containing the cursor. 
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LPEX Editor Functions: Preferences
Language-specific editor preferences

Enable auto syntax checking Enable auto 
uppercasing

Enter key 
behaviour

Tab key 
behaviour

In addition to preferences that apply to all languages, there are preferences that 
apply specifically to individual languages. 
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SEU Style Prefix Commands

SEU common prefix commands

ILE RPG Format Line prefix commands

ILE RPG Prompt prefix commands

OPM RPG prefix commands

Example:
I, I5, D, DD …etc.
FD, FC, FO, PP …etc.
PH, P?, PC, PO, PP …etc. 
F, F?, P, IP, IP? …etc

You can configure the LPEX editor to adopt the keyboard and command 
personalities of many popular editors. Most editor profiles differ only in the keys and 
commands used to perform various editor tasks. Some base editor profiles, listed 
below, also add a prefix information and command area at the start of each line:
ispf
seu
xedit. 
The editor recognizes prefix commands used by these editor profiles. Depending 
on which profile you are using, you can enter SEU, XEDIT, or ISPF commands 
when the prefix area is active.

By default, the SEU profile is the active profile. 
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Getting More Editor Space
Double-click on any Workbench view or Editor tab to 
maximize the view or Editor window

Views can be dragged around and stacked into 
tabbed notebooks

Views can be dragged to the left hand side of the 
Workbench as Fast views

– Single click on the Fast view icon to open the view

– Click anywhere else to close the view
Oh – oh, what have I done?

– Window -> Reset Perspective

You can easily double click on a view or editor tab to maximize the view or Editor 
window. If you double-click again you will return the view or Editor window to its 
original size.  You can easily rearrange views by selecting hem and dragging them 
to another location in the workbench. If you are going to use a view frequently but 
don’t ant to see it all the time in the workbench you can make it a Fast view. You 
select the view, right click and select ast view. The view will then appear in the left 
hand frame of the Workbench as a Fast view icon. 
To reset your workbench window to its original layout, you can select Window -> 
Reset perspective.



50

IBM Software Group  |  WebSphere software

iSeries Tools |  Remote System Explorer © 2004 IBM Corporation50

Fast View
Remote 
Systems 

view

Outline 
View

Tip:
Use the outline view (in fast view 

mode) to easily navigate in the 
editor while keeping the editor 
maximized!

Here you see an example of the Remote Systems view and the Outline view as 
Fast views in the workbench left hand frame.
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LPEX Editor Views – Outline view

Refresh:
This populates 

outline view

Click on entry to 
position to it

The Outline view helps you visualize the member you are editing by displaying all 
the program structures and functions in a clear-cut view.
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Code Assist

Use Ctrl+Space for 
context-sensitive 

selection

Vastly improved for 
RPG in 5.1 !

New for COBOL in 5.1 !

The Content Assist tool offers not only auto-complete functionality, by giving you a 
list of possible functions, objects or keywords to use, but also offers documentation 
on each of these to help you decide.



53

IBM Software Group  |  WebSphere software

iSeries Tools |  Remote System Explorer © 2004 IBM Corporation53

Help – at your Fingertips

RPG, Cobol,  DDS 
online references
Programming Guides
including CL
F1 Help

Sensitive to where cursor 
is in the editor

Message Help
and much more

Now you can have a ILE RPG reference at your finger tips.  Simply press F1
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Instant syntax checking
Errors inserted as “show 

lines” when cursors 
moves off line

Press F1 on error to get 
2nd-level help

The Remote Systems LPEX Editor gives you instant feedback for your code, at the 
location where a syntax error occurs. This happens as you cursor off a changed 
line.
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Verifying Verify runs built-in copy 
of the compiler

5.1: Automatically caches 
server info unless “Refresh”

cache option selected. 

Use the Source pulldown to verify your work. The verifier is a built-in copy of the 
compiler, for the purpose of catching all errors, not just syntax. The verify has 
options, which effectively are the subset of the compiler options that affect error 
checking. 
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Verify – Error List

Double clicking on 
error takes you to 

error in source

After performing a verify, the Error List window lists the errors that are found and 
their severity, inserts the error messages directly into the source and helps you to 
navigate between the errors. 
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Listing View

Verify with Prompt, 
select Generate 

Listing

Here is the Listing view from the Program Verifier, if that option was chosen.
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Compiling
To compile a member, 
use Compile pulldown
when editing, or right-
click menu on the 
member

Choose from existing 
compile commands 
or

Create or modify 
compile command

After you have verified and fixed all your errors, it is time to launch the compile. This 
is done via the Compile pulldown (only if editor is active) or the member’s popup 
menu. There are a number of compile commands pre-supplied for you, for each 
member type, or you can create your own compile command. Like user actions, 
these support substitution variables. Once you create a compile command, it 
appears in the cascading Compile menu. 

The last-used command, for this member’s type, is checked in the Compile menu. 
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Compile 
with 
prompt 
…

New 5.1 CL 
prompter

When you select to prompt the compile command, the command prompt is 
converted to a GUI and displayed. For the 5.1 release, this GUI was re-written from 
Java’s Swing to Eclipse’s SWT so it more consistent with the rest of the dialogs in 
the IDE.
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Indent View

Here you see the results of the indent option: a readonly view showing the code 
indented, much as it is in a compiler listing, but with color.
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Show Fields

Here you see the results of the Show Fields tool. It retrieves the fields for the file 
under the cursor, and shows the fields in a table view.
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Integrated Compare

The compare tool under the Edit menu is used to compare the currently active 
member in the editor with another member you select, and the differences are 
shown within the edit window, as we see here. 

Alternatively, there is another compare utility not editor based, in the popup menu 
for members. 
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Filtering Right click in editor 
to filter view

Only lines meeting 
filter criteria are 

shown Use + / - to expand 
or collapse filtered 

sections

A very popular feature of LPEX is its support for subsetting the source to show only 
lines meeting a criteria, such as containing a given string or representing the begin 
or end of a subroutine / procedure. This capability is accessed from the right click 
menu of the editor. In subset mode, you will notice plus signs, that if expanded will 
un-hide the lines up to the next visible line. 
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New Procedure wizard

Procedure wizard 
generates 

prototype and 
body stub

NEW FOR 5.1 !

In 5.1, the Procedure SmartGuide from CODE/400 was ported to the new editor. 
This will prompt for a procedures signature information (name, parameters and 
return type) and generate the procedure prototype and the body. It is up to you to 
subsequently add logic to that body. 

The prototype is generated at the top, after the last D-spec, while the body is placed 
at the bottom of the current member. 
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New Procedure wizard

Procedure wizard 
helps with 

complexity of RPG 
language

Flyover help 
describes each 

option

The procedure wizard can help with users not fully familiar with RPG IV, especially 
for the parameters and return type information. 
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Remote System Explorer

Designer

Now we’ll describe the CODE Designer tool, launchable from the IDE.
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CODE Designer
Use Open With -> 
CODE Designer to 
open designer
– For DSPF, PRTF, 

PF

– Launches in 
separate window

– Currently no built-
in DDS designer, 
but built-in source 
editor does support 
DDS

CODE Designer is an editor like SDA and RLU, for WYSIWYG development of 
display files and printer files. It also supports physical files. 

Unlike the source editor, this editor has not been ported into the IDE yet, so those 
wanting a great WYSIWYG tool have to use it still. To make that easy, there is a 
right click action to launch it from a selected member. 
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CODE Designer

This is the CODE Designer. As you can see, because its not in the IDE, it launches 
in its own main window. 
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CODE Designer
Graphical design tool for DDS

display files - screens
printer files - reports
physical files - databases

Powerful intuitive interface
Lets novice create DDS quickly and easily while giving 

expert access to all the features of DDS
WYSIWYG graphical design - Drag/drop ease
Properties notebook 
Integrated local verifier
Explorer-like browsing of DDS hierarchy

CODE Designer is a very popular and powerful tool. 
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Toolbar

Screens

Palette

Design 
Page –
WYSIWYG 
Layout

WYSIWYG 
editing

DDS source

This is the equivalent of SDA’s option 12 design screen. It is rich in toolbar and 
palette items, and supports drag and drop, and direct editing. 
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Explorer for DDS

DDS Explorer

Field List

DDS source

For those who prefer non-WYSIWYG, there is also a field list where you can create, 
change and re-order fields. It contents changes as records are selected in the DDS 
Explorer primary view on the left. The field list is the only option for PF editing. 
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Remote System Explorer

Integrated iSeries 
Debugger

With the Integrated iSeries Debugger you can debug your program running on the 
iSeries host from a graphical user interface on your workstation. You can also set 
breakpoints before running the debugger, by inserting breakpoints directly in your 
source while editing. The integrated iSeries debugger client user interface also 
enables you to control program execution. For example, you can run your program, 
set line, watch, and service entry point breakpoints, step through program 
instructions, examine variables, and examine the call stack. You can also debug 
multiple applications, which may be written in different languages, from a single 
debugger window. Each session you debug is listed separately in the Debug view.
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Integrated iSeries Debugger - Overview
Supports many languages

RPG, COBOL, CL, C, and C++
ILE and non ILE

Java
Supports many views

Source and Listing Batch and interactive
Supports many applications

Batch and Job

Interactive

Multi-Threaded Applications 

Client/Server Applications

Distributed Applications

The Integrated iSeries Debugger is powerful and complete.
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Debugger Invocation: from popup menus
Debug As… from Popup 

menu of:
*PGM, *SRVPGM, job

Debug As…
Batch, Int’ve, Multi-threaded

You can run and debug programs from the Remote Systems view or the iSeries 
Table view in three ways: 
•In a batch job
•In an interactive job 
•In a server job
In the third case, running the program will use the same job as the Remote System 
Explorer communications server job. With batch and interactive jobs, you cannot 
monitor the status as easily, however, you do not tie up your communications server 
and you are notified when the program command ends. Batch jobs work as you 
would expect and do not require any initial setup. 
Note: A multi-threaded debug session creates a new server job and this way keeps 
the RSE communications server job free for other tasks.
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Debugger Configurations: for easy re-use!

Existing debug configurations are easily 
accessible in debug pulldown!

Debug configurations are for powerful re-use. If what you want to debug takes a 
number of parameters, or is not straightforward to launch, you can predefine this 
information into a named configuration. Once created, the configuration appears in 
the dropdown for the debug icon, and can be selected easily. 
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Debug Perspective Resume, Suspend, Terminate, Step Into, 
Step Over

Call 
Stack

Break 
Point

Current 
Line

Examine / 
Change 
Fields

Debug Perspective
Debug view
Source view (debug editor)
Numerous other views

Here we see the common Eclipse Debug perspective, which is being used to debug 
an RPG program.  The common debug user interface has been connected to the 
iSeries debug engine in Version 5.0, to offer a common and compelling debug story 
for OPM/ILE RPG and COBOL and CL, and ILE C and C++. 
In the upper left pane is the call stack, much like option 11 in the OS/400’s 
WRKACTJOB. It shows the calls that reflect your current program execution. When 
you double click an item in the stack, its source (if available) is shown in the source 
pane in the middle. The upper right is where all the various views are for working 
with data contents, breakpoints etc.. The middle is the debugger source view, with 
source executable (debug) lines in blue, others in green.  The current line of 
execution is highlighted, and breakpoints appear as a dot with a check mark in the 
left margin. 
Although not part of the common Debug Perspective, the Properties view contains 
valuable information about the selected object, which could be a breakpoint 
selected in the Breakpoints view, an entry selected in the call stack, etc. To add the 
Properties view, click on the menu item Window and Show View on the pull down 
menu, select Other from the submenu , expand Basic, select Properties and click 
OK.
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Setting Breakpoints

Setting Breakpoints:
Double click in prefix area
Prefix area popup menu
Source popup menu
Breakpoints view popup menu

You can only set breakpoints at executable lines. All executables lines are displayed 
in blue.
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New editor breakpoint:
Double click in prefix area or
Use prefix area popup menu Editor

This is the dialog for edit breakpoints. Enter the library name and select Program or 
Service Program. The breakpoint is shown as a dot in the prefix area. If there is an 
active debug session, the breakpoint will be set in that session and there will be no 
marker in the editor. The breakpoint is then listed in the Breakpoints view in the 
Debug perspective.
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Remote System Explorer

Reference:
Getting Fixes
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Getting Service Packs and Verifying PTFs

To get client service packs:
Use Help->Software Updates->New Updates

Repeat until told no more updates (4 
times)

To verify you have needed host PTFs:
On an iSeries connection, right click on 

iSeries Objects subsystem
Select Verify Connection

Please try the RSE! And to ensure success, we want to ensure you have the latest 
client and server fixes.
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Remote System Explorer

Reference:
What’s New
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What’s new in RSE for Version 5.0
Library list manipulation support
More wizards, improved user actions and compile support
Drag and drop
PDM-like table view with command line
Editor enhancements:

– Syntax checking for RPG, COBOL, DDS, CL
– Program verifiers for RPG, COBOL, DDS
– F1 help support for RPG, COBOL, DDS, CL
– Outline view for RPG, COBOL + content assist for RPG
– List fields support for F-spec, COPY-DDS
– Performance enhancements

Rich command console for Unix, Windows, Linux, Windows
New common debug UI, and editor breakpoint support
Remote Text Search (eg, FNDSTRPDM interface)

A partial list

Some of the primary enhancements in 5.0 are: 

•Support for a new library list filter, and actions for manipulating the library list. This is much like *LIBL support in 
WRKLIBPDM.
•New easy-to-use wizards to create libraries, files, members, data areas, data queues and message files.
•Ability to drag source members to another file, or another iSeries, or to any other system such as local, UNIX, Windows and 
Linux source files.
•The primary view in Remote Systems Explorer is the Remote Systems tree view, but PDM users are used to a table view, so 
there is now an iSeries Table view that shows what the Remote Systems tree view shows, but in table format. You can sort 
the columns when you click on the column heading. The contents of the table are easily replaced for example when you 
double click on a file. There are right-click actions that are the same as PDM’s, and a command line at the bottom just like in 
PDM.
•The Remote Systems LPEX Editor is now well beyond SEU’s function, and getting close to all of CODE’s. The syntax 
checker is ported down from SEU, the compilers are imbedded for verifying all errors, and the reference manuals are built-in 
and F1 cursor sensitive. There is a new outline view showing the program hierarchy at a glance, and something really cool 
called Content assist which offers lists of options for code-completion based on the location of the cursor in the source. You 
invoke Content assist easily in the editor through the Ctrl+spacebar keys. 
•The List fields option is available when the cursor is on an F-spec or COBOL Copy-DDS statement. This option opens a 
Window that shows all the fields in the referenced file.
•There are also significant enhancements to the editor’s open, save and runtime performance. 
•A new command console is available for QShell, UNIX, Windows, Linux and local which are very rich in capability. You can 
run any command remotely, and see the feedback. The feedback is parsed, so when listing files, for example, you can 
double click to open the file. Or double click on a folder name to open a table view on the folder’s contents. 
•The common Eclipse-supplied Debug perspective to iSeries programs is integrated into the workbench, offering skills 
transfer. You can set breakpoints in the built-in Remote Systems LPEX editor, and then run to the breakpoint. This opens the 
Debug perspective. There is also new support for the common Eclipse run-configurations and debug-configurations.
•The Remote Text Search is a local GUI interface to FNDSTRPDM (find string PDM) that searches remote members for a 
given string. The results are shown in a local window, and you can double click to open the editor and position the cursor.
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What’s new in RSE for Version 5.1
Improved caching support for Program Verifiers
Enhancements to CL command prompting 
Multiple-selection for compiles
Expandable *PGMs, *SRVPGMs (to see modules)
Expandable modules (to see exported procedures)
Editor wizard for creating RPG IV procedures
Editor enhance’ts to RPG IV, COBOL outline view and code assist
Editor template support for RPG IV free form, COBOL, C and C++
Editor quick-open dialog (Ctrl+Shift+N)
Remote Agent Controller support for iSeries 

Enables publishing of Web projects and profiling of Java code
Enhancements to Linux/Unix/Windows/QShell support

Compare two files, or two versions of same file 
Replace file from local history
Drag ‘n drop to editor, Drag ‘n drop to populate filters
Content assist for commands, in console A partial list

Some of the primary enhancements in the 5.1 release are listed here.

•Improved caching for the verifiers. This now behaves as it did in CODE – the cache information is used if available, unless 
the refresh-cache option is chosen. This can significantly improve verifier performance.
•CL command prompting is now SWT-based versus Swing-based, so it looks like the rest of the IDE.
•It is now possible to select multiple members to submit to compile. The order they are compiled is configurable by member 
type.
•Program objects are expandable to show modules. 
•Modules objects are expandable to show exported procedures within the module.
•The CODE/400 SmartGuide for creating new procedures has been ported to the new editor, and enhanced
•The outline view for RPG IV shows more information now, and positions properly when items selected. There is totally new 
support for code assist for COBOL, and the RPG IV code assist is way better with support for parameters to keywords, 
functions, etc and case sensitivity. 
•There is a new action from the local toolbar of the Remote Systems view to quickly open a member for edit or browse. It is 
also easily invoked via Ctrl+Shift+N. This can be faster than drilling down if you know what you want to edit.
•The Remote Agent Controller has been ported to iSeries, as well as the agents that come with it for Web publishing and 
Java profiling. See the documentation for more details. There are also actions in the RSE now for starting and stopping the 
RAC server on the iSeries.
•The non-iSeries support is also much enhanced this release:
•New actions to compare a file with another, or another version of itself.
•New action to replace a file with a previous version from the local history. Each edit of the file creates a new local history.
•Open files by dragging them to the editor.
•Add folders/files to filters by dragging them to a filter.
•Use Ctrl+Space in the command console to see a list of commands available (built-in plus on path). 
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Additional Information
homepage:  
http://ibm.com/software/awdtools/wds400

Select Library link for Labs, Tutorials, Presentations

newsgroup: 
news://news.software.ibm.com/ibm.software.

websphere.code400

email distribution list:
“This is the Websphere Development Studio Client for iSeries  (WDSCI-L) 

mailing list
To post a message email: WDSCI-L@midrange.com
To subscribe, unsubscribe, or change list options,

visit: http://lists.midrange.com/mailman/listinfo/wdsci-l
or email: WDSCI-L-request@midrange.com

Before posting, please take a moment to review the archives
at http://archive.midrange.com/wdsci-l.”

We hope this presentation helped you understand more about Development Studio 
Client iSeries application development tools.  We started with an overview of our 
strategy for iSeries application development tools, went onto review the Remote 
System Explorer, the perspective for iSeries programmers to maintain and develop 
iSeries applications and explained how to extend RSE to include your own iSeries 
application development tools. 
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test and is distributed on an as is basis without any warranty either express or implied.  
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to their own environment do so at their own risk.

Reproduction:
The base presentation is the property of IBM Corporation.  Permission must be obtained 
PRIOR to making copies of this material for any reason.
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All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.  Contact your local IBM 
office or IBM authorized reseller for the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities.  Such information is not intended as a definitive statement of a commitment to specific levels of 
performance, function or delivery schedules with respect to any future products.  Such commitments are only made in IBM product announcements.  The information is 
presented here to communicate IBM's current investment and development activities as a good faith effort to help with our customers' future planning. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment.  The actual throughput or performance that any user will 
experience will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the 
workload processed.  Therefore, no assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.
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